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Conventions

PPA for DM Manual

The typographic conventions used in this manual are described below.

Convention

Bold

Menu...MenuOption

CAPS

Italics

Description

Used to denote specified elements of the user interface such as
buttons, field names, menus, and menu options.
For example, the New button.

Select the Menu from the Menu bar then select the Menu Option
from the Menu.

For example, File...Open would mean select the File Menu and
then the Open Option.

Used to denote the name of a key on the keyboard.
For example, the ENTER key.

Used to denote emphasis, captions and the result of an action in a
procedure.
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Introduction to Peak Pairs Analysis (PPA)

PPA stands for Peak Pairs Analysis, the DigitalMicrograph plug-in for High-Resolution Peak
Measurement and Strain Mapping Analysis.

All results obtained by PPA are fully compatible with the other functions present in DM. For
example, strain maps can be analyzed and/or manipulated with functions such as histograms,
statistics (mean, standard deviation, min, max etc.), or using the corresponding buttons, such
as the Profile utility.

The main reference for the algorithm is:

The Peak Pairs algorithm for strain mapping from HRTEM images

Pedro L. Galindo, Stawomir Kret, Ana M. Sanchez, Jean-Yves Laval, Andrés Yafez,
Joaquin Pizarro, Elisa Guerrero, Teresa Ben and Sergio 1. Molina

Ultramicroscopy 107 (2007) 11861193 (doi: 10.1016/j.ultramic.2007.01.019)

This manual will help you to use of the PPA package with some worked examples. There is
also a quick reference guide at the end of this document.

Software requirements

The following is a list of the software requirements necessary to run the PPA plug-in:

- DigitalMicrograph (Gatan™ )
- USB Key Driver
-  HREM Mouse Tool Plug-in (freeware downloadable from www.hremresearch.com)

- IPU Plug-in (freeware downloadable from www.hremresearch.com)



HREM Research Inc. PPA for DM Manual

Software Installation

Installing USB Key Driver

The user key driver should be installed by following the instructions given by the key driver
installer. You can find the key driver installer at the plug-in page on HREM Research web
site.

Installing DigitalMicrograph Plug-ins

The DigitalMicrograph Plug-in will be provided as Gatan compiled script file(s) (.gtk) and
dynamic link library file(s) (.dll). All these files can be installed by copy-and-paste to the
folder “Pluglns.” (The Pluglns folder should exist under a normal installation of the
DigitalMicrograph).

When the DigitalMicrograph is launched after placing the plug-ins into the Pluglns folder, the
Pluglns will appear as a new menu or an addition to the standard tools.

Installing Mouse Tools i o £ R {fg )

All the files relating Mouse tool plug-in can be installed
by copy-and-paste to the folder “Pluglns.” The Mouse
tool will appear as an addition to the standard tools.

Installing IPU Plug-in

The PPA plug-in uses some functions based on the Intel’” MKL (Math Kernel Library)
provided by the IPU plug-in. All the files relating the IPU plug-in can be installed by copy-
and-paste copy. The IPU plug-in will appear as under /PU menu. Please consult the ReadMe
file that comes with the IPU plug-in.

Installing PPA [Festrars Dt

Fourier Space Noise Filter 4
PeakPairs.gtk and PeakPairs.dll can be installed by drag- Real Space Notse Filter ’
and-copy to the folder “Pluglns” (The Pluglns folder Set Reference Base Vectors
should exist under a normal installation of the Motif Detection >
DigitalMicrograph.) Find Peaks »

Find Peak Pairs

When the DigitalMicrograph is launched after placing the

Displacement Maps

plug-ins into the Pluglns folder, PeakPairs menu DT
commands will appear. Correct Scan Line Noise...
Strain Map...

Repeat Project...
Project 4
Image Group >

Analyze Peak Points

Analyze Equivalent Columns...
Histogram from Spreadsheet
Show/Hide 4
Add Color Marker

Create Vector Map...

Distortion Correction 4

Help 4
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Getting Started

Image pre-processing and Basis Vector Selection

(Bragg Filter)

PPA for DM Manual

Open the file QuantumWire.dm3 using the DM command File...Open:

-

i F: QuantumWire
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This image represents a
capped InAs quantum
wire on GaAs.

Composition was consi-
dered to be uniform
inside the quantum wire
and across the wetting

All the commands related to PPA are located in the menu Peak Pairs. The first command to
be applied to a new image is the Power Spectrum command to calculate the power

spectrum of the image:

PeakPairs

e

Fourier Space Noise Filter

Real Space Noise Filter
Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project

Image Group

Analyze Peak Points

Analyze Equivalent Columns...

Hictanram fram CSnraadchaat

Power Spectrum

Bragg Filter...

¢ D: Power Spectrum of QuantumWire [fol-a =
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Now, select the HREM mouse tool, and
click on desired spots to apply Bragg filter.
The usual choice is to select the brightest
spots in the spectrum, but those
corresponding to higher harmonics can also
be selected:

The user doesn’t need to hit the spot exactly,
because PPA looks for the local maxima near
the selected point.

Anyway, if necessary, you can zoom in the
spectrum before hitting peaks using the DM
zoom tool:

= D: Power Spectrum of QuantumWire

PPA for DM Manual

i & L R} @ T

Y o9 W

Hint: if you wish to delete any spot,
just click on the mouse mark again
with the SHIFT key down.

Hint: Symmetry in the selection for
each spot is assumed.

IMPORTANT: First and second chosen spots (numbered as 1 and 2) will define the lattice
basis vectors. These spots should be apart from the vertical or horizontal of the central spot, in

order to obtain maximum resolution.

Don’t be surprised if the central spot is not present in the power spectrum. It just indicates that

the mean intensity of the image is zero.
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We are now ready to apply Bragg Filter. This process creates an image where the contrast
resulting from the ordered regions is clearly distinguishable from the background intensity.

PeakPairs

Fourier Space Noise Filter » Power Spectrum

Real Space Noise Filter » C Bragg Filter... )

Set Reference Base Vectors

Motif Detection »
Find Peaks »

Find Peak Pairs
Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project »
Image Group »

Analyze Peak Points

Analvze Equivalent Columns...

= D: Power Spectrum of QuantumWire

Let us select the first option (small
window, oval ratio=1) and press the OK
button, and the Bragg filtered image will
appear immediately.

If Bragg filter parameters are properly
chosen (big masks and a sufficient
number of peaks), the resulting filtered
image will preserve the location of
maxima. The great advantage in using
the filtered image is the reduction of
noise.

riz Bragg Filter [
Project Name: | Project 1|

Size:
309 poet
Smoothing Width: W
[“|ovalRatio: [0.5
Direction: W degree

[ OK ] [ Cancel

The shape and size of the Bragg filter must be
adjusted such that no loss of information occurs. In
this dialog box we can determine the size (in
pixels), smoothing width(in pixels), oval
ratio(height/width) and direction(in degrees) of
mask spots.

By pressing the Apply button, the mask described

by the chosen parameters will be redrawn, as it is

shown in the example on the left.

= Bragg Filter &J
Prieot Neme: [Fraeeii ——

Size:

Small - 309 pixels
Smoothing Width: |50
o
|~ Owval Ratio: [05

Direction: [450 degree
oK Cancel

v 4
N

= L: Project1 Bragg Filtered QuantumWire o[- @
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Peak Detection (for simple structure images)

IMPORTANT: Peak Detection uses two base vectors information (unit cell) to find a set of
good intensity peaks. The Bragg filter defines the two base vectors automatically. However,
in the case of the Real Space Noise Filter, the two base vectors should be defined

manually using the Set Reference Base vectors command.

Once we have a Bragg filtered image, the next step is to locate peaks of intensity in the image

by using the Find Peaks menu commands.

The approach to peak detection is based on peak
identification based on their intensities.

The Peak Histogram command detects all
intensity maxima in the image, and calculates the
histogram of peak intensities.

The histogram allows the user locating different sets
of peaks, based on their intensities, for determining
strain. This discrimination is obtained by defining a
lower threshold using the histogram. All peaks of
intensity lower than this threshold are discarded.

Project

Here, we use Test image.dm3 as a sample data. First, we
apply the Bragg filter using all the spots in the Power
Spectrum. When the command Peak Histogram is issued,
the following dialog box allows the user to specify if the user
is interested in white (unchecked) or black spots (checked)
using the Invert Peaks checkbox option

After clicking OK, the HREM Histogram tool shown right
will appear as well as a new window showing the histogram
of all the peaks found in the image. The default range of the
histogram is set to the maximum and minimum of the peaks.
If you want, you can change the histogram range as well as
the number of bins. When you change these values, push the
“Apply” button.

Real Space Noise Filter 4
Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...

Image Group >

Analyze Peak Points

Analyze Equivalent Columns...

PeakPairs

Fourier Space Noise Filter >

»
» Peak Histogram...
T SITIoNS...

Remove Peaks

Add Peaks

iz Peak Histogram [

[ | Invert Peaks
[ oK ] [ Cancel ]
HREM Histogram X

Select threshold and press OK

Min: | 1.2947 Max: |3.127

No of bins: | 100

[Cancel] [Home] [Apply]

Once the histogram is shown, the user should select the intensity threshold for identifying
which peaks will be used in further analysis. To do so, just click the mouse on the histogram,
and select the desired range of peaks. The left side of the selection made in the histogram will

be used in the following Find Peak Positions command.

10
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_*_ L ’E‘i | A / Fa N | iz F: Peak Histogram of Project2 Bragg Filtered Test image

2

k Select 200
Select and move objects 180

160

o
|
=

140

120

100

80-

60-

40-
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2.705 He———0.442 ———¢

1.4 16 1.8 2.0 22 24 26 28 3.0

HREM Histogram X
Select threshold and press OK

Min: |1.2947 Max: |3.127

No of bins: | 100

§ancel | | Home | | Apply

4

The discovered peaks will be classified to red or blue depending on the peak values: red
indicate the peak that is higher value than the selected threshold, while blue indicate the peak

equal to or lower than the threshold. The peak colour will be dynamically revised by changing
the threshold (the left-edge of the Range ROI).

When you satisfy the threshold by looking the motif markers (red or blue), push the “OK”
button of the Histogram tool, or the “Cancel” button to stop the process.

11
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Once the range of peaks is selected, the next step is to refine the peak positions using the
Find Peak Positions.

PeakPairs The following dialog box appears:
Fourier Space Noise Filter 4
Real Space Noise Filter > f’f Find Peaks &J
Set Reference Base Vectors m Invert Peaks

Motif Detection

Peak Threshold: |0.825
Find Peaks |__Psakhistonian,

3
»
. < Find Peak Positions...> Approximate Column Size (diameter): | 3.0
S

Displacement Maps (V] Show Local Maxima

Define Reference SeCibELE [

Correct Scan Line Noise... OK ] [ Cancel ]
Strain Map...
Peak Threshold indicates the minimum intensity

Repeat Project...

Project > of a point to be considered as a valid peak. Peaks
Image Group > having intensities below this threshold will be
Analyze Peak Points discarded. Peak threshold value is automatically
Analyze Equivalent Columns... read from the left side of the selection made in the
Histogram from Spreadsheet histogram. However, the user can manually
S o modify this value, if necessary.

Add Color Marker

Create Vector Map... You may want to use Approximate Column
Distortion Correction > Size (in pixel) to merge the peaks (columns)

within the specified column size.

Help 4

By pressing OK, we get a first set of peaks shown as coloured spots over the filtered image.
Blue dots represent local maxima (8-neighbourhood) on a pixel basis. Red dots represent
refined maxima at sub-pixel resolution. Sub-pixel resolution is achieved by fitting a 2D
quadratic function and calculating analytically the maxima, as described in the reference for
the algorithm in the Introduction section.

¢z H: Project1 Bragg Filtered Test image =[5 ¢ H: Project1 Bragg Filtered Test image

Sometimes, extra peaks are obtained in this automatic Peak Finding process, especially at the
borders of the image. Repeating the Find Peaks command with a new Peak Threshold, all
peaks in the border of the image will be discarded and won’t be considered in any further
calculations.

12
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Motif Detection (for complex structure images)

In cases where the repeating unit in the image is more complex than a single dot, such as a
dumbbell, an alternative, more complex way to determine the lattice may be useful. Thus, the
Motif Detection has been implemented. Here, we explain the Motif detection using the
image QuantumWire.dm3.

First, a rectangle should be defined using the Rectangle ROI tool. The rectangle defines the
basic pattern that will be searched across the whole image using normalized cross-correlation.
For example, in this image, a cation location (an upper part of a dumbbell) may be a good
choice. Rectangle size and location is a critical decision in the accuracy of strain results. Let
us zoom in the substrate, and select a rectangle area around a cation.

- L: Project! Bragg Filtered QuantumWire [o]o =)

"1 Rectangle
Add a rectangle ROIL

Once the rectangle ROI has been placed, you can rotate the Motif ROI, if you want. To do so,
please select the Define motif in the Motif Detection submenu. (how to rotate the ROI,
consult the Define Reference command)

[Peakpairs | = H: Project1 Bragg Fitered QuantumWire

Fourier Space Noise Filter >

Real Space Noise Filter >

Set Reference Base Vectors

Motif Detection Define Motif

Find Peaks =

Find Peak Pairs x-Corr with Refined Motif
Displacement Maps Find Motif Centers...

Define Reference

Correct Scan Line Noise...

Strain Map...

Repeat Project...

Once the Motif has been defined, select the x-Corr Histogram in the Motif Detection
submenu. A dialog shown below will open:

PeakPairs - . |! g !I
Fourier Space Noise Filter » t"#'_' X-COI’I’ HlStOQram
Real Space Noise Filter »
Set Reference Base Vectors Project Name: I Projectl

Find Peak Pairs " - - -
Find Motif Centers... Minimum Motif Distance: | 10.0

Define Reference [

Motif Detection » - . .
— dm Approximate Column Size (diameter): | 10.0
- =

Displacement Maps

OK ][ Cancel ]

Correct Scan Line Noise...

After clicking OK, the HREM Histogram tool shown below and a new window will appear
showing the histogram of all maxima found in the Cross-Correlation map, obtained using the
User-Selected motif and the whole image.

13
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HREM HiStO gram tO 01 = P: Peak Histogram_X-corr of Motif With Project1 Bragg Filtered QuantumWire ===

HREM Histogram X
Select threshold and press OK

Min: Io.s Max: |1.0

No of bins: | 200 |
(oK | [cancel | [Home | [Apply | R

In this case, we may observe two peaks in the histogram, corresponding to Ga and In cations
across the image. The default range of the histogram is set to 0.5 to 1.0. If you want, you can
change the histogram range as well as the number of bins. When you change these values,
push the “Apply” button.

Once the histogram is shown, you should select the intensity threshold for identifying which
peaks will be used in further analysis. To do so, just click the mouse on the histogram, and
select the desired range of peaks.

i Q | A / )/ . . = Lt Peak Histogram_X-corr of Motif With Project1 Bragg Filtered QuantumWire =3 ]
E *— _s
W A ]

Select 250
Select and move objects

036 %004 -]
050 oS os0  oes o7 o7 os  oss 0% o3 100

The discovered motifs will be classified to red or blue depending on their cross-correlation
values: red indicate the motif, whose cross-correlation value is higher than the selected
threshold, while blue indicate the motif equal to or lower than the threshold. The peak color
will be dynamically revised by changing the threshold.

i H: Project Bragg Filtered QuantumWire

Given that we are interested in the detection of both cations, we will select a threshold lower
than 0.9 to take all peaks into consideration. To do that, the Select tool should be used by
dragging the mouse on the histogram directly. The left edge will be used as a lower threshold.

14
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@QIA/}’II

k Select -
1l

Select and move objects

PPA for DM Manual

iz P: Peak Histogram_X-corr of Motif With Project1 Bragg Filtered QuantumWire

=[O ]

When you satisfy the threshold by looking the motif markers (red or blue), push the “OK”
button of the Histogram tool, or the “Cancel” button to stop the process.

If you push the “OK” button, the first refined motif is calculated by averaging all patterns
associated to each point in the histogram above the chosen threshold (0.91 in the figure). The
average motif is automatically shown:

HREM Histogram X e

Select threshold and press OK

Min: |0.5

No of bins: | 200

-

The second step of the Motif detection is calculating the cross-coefficients using the refined
motif. To do so, select the x-Corr with Refined Motif command.

PeakPairs

Max: | 1.0

Fourier Space Noise Filter

Real Space Noise Filter
Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps

Define Reference

4
>

v v

Define Motif

x-Corr Histogram...
P x-Corr with Refined Moan
— §

Then, this command will show the HREM Histogram tool and the cross-correlation between
the refined Motif and the whole image. This is especially useful in the presence of noise.

HREM Histogram

Select threshold and press OK

Min: |0.5 Max: | 1.0

200

No of bins:

[Cancel] [Home] [Apply]

450

.;,: T: Peak Histogram_X-corr of Refined Motif with QuantumWire

[E=8 HoR ==

400

350-

300-

250-

200-

150-

100-

Once the refined histogram is shown, the user should select the intensity threshold on the
refined histogram as before.

15
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p =Ry N #: T: Peak Histogram_X-corr of Refined Motif with QuantumWire == E=n )
g - >

450

k Seled 400-
Select and move objects

The discovered motifs will be classified to red or blue as before. The peak colour will be
dynamically revised by changing the threshold. When you satisfy the threshold by looking the
motif markers (red or blue), push the “OK” button of the Histogram tool. Then, the second
refined motif will be shown.

tiz H: Project1 Bragg Filtered QuantumWire [ @][=

HREM Histogram X
Select threshold and press OK

Min: IT Max: |1.0 >
No of bins: |200
ncel] [Home] [Apply]

The final step of the Motif detection is finding the motif centers. To do so, select the Find
Motif Centers in the Motif Detection submenu.

PeakPairs X . - @ gl

Fourier Space Noise Filter » t‘."": Flnd MOtIf Cen' -

Real Space Noise Filter >

Set Reference Base Vectors peak ThreShOId: I E

Motif Detection » Define Motif Show all points

Find Peaks » x-Corr Histogram... .
Show stacked motif

Find Peak Pairs M

Displacement Maps Find Motif Centers... [ OK J [ C |

ancel ]
Define Reference

The Find Motif Centers command finds the motif positions by taking into account the
minimum motif distance, and places the red small boxes on the motif centers (the center of
the motif box).

E;—_- B: Project1 Bragg Filtered QuantumWire

IMPORTANT: In the case of Motif Detection, the reference base vectors should be selected
using the Set Reference Base vectors before applying the Find Peak Pairs command.

16
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Peak Pairs Determination

IMPORTANT: Peak Pairs are calculated using two basis vectors. The Bragg filter defines
the two base vectors automatically. However, in the case of the Real Space Noise Filter or
Motif Detection, the two base vectors should be defined manually using the Set
Reference Base Vectors command.

Once all peaks or motif centers have been selected, Peak Pairs should be calculated using the
Find Peak Pairs command. This process will find all pairs of peaks along the predefined
two basis vectors.

PeakPairs | Help i H: Bragg Filtered Test image [ [=1E]
Fourier Space Noise Filter . .

Real Space Noise Filter 2 p

Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs

Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project

Image Group

Analyze Peak Points

Analyze Equivalent Columns... Peak Flndlng

Histogram from Spreadsheet

Show/Hide 4
Add Color Marker
Create Vector Map...

Distortion Correction 4

Help >

Motif Detection

17
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Displacement and Strain Maps calculation

Once all Peak Pairs have been determined, we can proceed to the calculation of displacement
maps using the command Displacement Maps. This generates horizontal and vertical

displacements (D1h, D1v, D2h and D2v).
PeakPairs | Help

Fourier Space Noise Filter

Real Space Noise Filter
Set Reference Base Vectors

Motif Detection
Find Peaks

>
>

Analyze Peak Points
Analyze Equivalent Columns...
Histogram from Spreadsheet

Show/Hide

c Displacement Maps D
T —DEeRererenee
Correct Scan Line Noise...
Strain Map...
Repeat Project...
Project >
Image Group >

= Q: Project1 D1h

ol ek

T T: Project1 D1v

w31 & " e
MIL A

Technical note:

PPA wuses an automatic selection of contrast and the temperature color scale for
displaying image values. Default color range is =1 pixel.

If you prefer a grey scale or a different contrast limit, press the right button on the
image, and modify ImageDisplay options properly.

Changing this option will not change the actual values, only its appearance.

A very important step is to define the Reference Area, that is to say, the area that is considered

to correspond to the reference lattice.

All displacements and strain values will be referred to this area. Use the Rectangle ROI tool
(region of interest tool) to select an area on any one of the Displacement images (D1h, D1v,

D2h or D2v):

t .1 Rectangle
Add a rectangle ROI

1= Q: Projectl D1h

18
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Once the Rectangle ROI has been placed, the user should select the Define Reference
command. This will change the displacement values, so as to obtain a uniform displacement

in the chosen reference area.

PeakPairs | Help
Fourier Space Noise Filter »
Real Space Noise Filter »
Set Reference Base Vectors
Motif Detection »
Find Peaks »
Find Peak Pairs
Di
Define Reference
cor
Strain Map...
Repeat Project...
Project »
Image Group »
Analyze Peak Points
Analyze Equivalent Columns...
Histogram from Spreadsheet
Show/Hide »
Add Color Marker
Create Vector Map...
Distortion Correction »
Help »

= P: Project1 D1h

F=JEe &S | & v: Project1 D1v

g Us Project1 D2h

The Define Reference command makes the Rectangle ROI rotatable. You can change the

size and angle as shown below, if you want:

= Q: Project1 D1h

(= HE ]

You can adjust the edge length by selecting
the yellow edge and dragging the handle,
and rotate the ROI by dragging the yellow
cross (+).

You can adjust the both edge lengths by
dragging the yellow cross when pressing the
SHIFT key.

When you change the ROI shape or displace the ROI, the average displacement within the
ROI will be automatically set to zero.

The final step is the determination of strain maps (exx,yy,€xy and eyx) at the desired angle.
When the Strain Map command is selected, the Strain Map dialog appears. Here, you can
specify the coordinate axes to display the strain maps using Angle of x-axis to horizontal. If
the angle is set equal to 0, horizontal and vertical directions are assumed to be x and y

coordinate axis respectively.

Find Peak Pairs
Displacement Maps
Define Reference

Corred

Repeat Project...
Project

Image Group

Analyze Peak Points

Show/Hide
Add Color Marker

Strain Map...

Analyze Equivalent Columns...

Histogram from Spreadsheet

19

e Strain Map B

Option

Angle of x-axis to horizontal: |7.5 ‘

~Show the following images
Strain Matrix

() Independent
@ Symmetric
[ Mean Dilatation

[~ |Rotation Angle
5




HREM Research Inc. PPA for DM Manual

The angle of x-axis to horizontal may be determined graphically. To do so, just add a Line
ROI on the original image, along the desired direction of x-axis, before issuing the Strain
Map command.

= F: QuantumWire

NI =

,." Line
Add a line ROI

Once the OK button is chosen, a set of 4 images corresponding to (exx,€yy,€xy and eyy) are
obtained. The mean dilatation and Rotation angle are additional images available.

There is an option for strain representation (Overlay):

DESCRIPTION Full image Detail

No overlay:
Continuous strain
maps are shown.

*l | ke projecti exx [ ][ & )

Hint: If you prefer a grey scale or a
different contrast limit, press the right
button on the image, and modify
ImageDisplay options properly.

|

Overlay:

Strain maps at
each atomic
column are
shown with
colour dots over
the original
images.
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Setting the Reference Base Vectors

It is possible to manually set the reference base vectors.

To manually define the Reference Base vectors, use the HREM Mouse Tool to select 3
points in the order (origin of both vectors, terminal point of vector 1, terminal point of vector
2), so that the directions of the desired reference base vectors are described by the directions
of vectors 1->2and 1->3.

(0sidE)

®
™
L]
™
‘s
-

‘R EEE N
. B8 .

Approximate directions
as described by the user

When applying the Set Reference Base Vectors command, the precise magnitude and
direction of both reference base vectors are calculated using a least-squares fitting to all the
peaks within the parallelogram defined by two vectors 1->2and 1->3.

Peakpars | Hep & C: Project] LPF of PPA Test 1

Fourier Space Noise Filter >

Real Space Noise Filter >

< Set Reference Base Vectors

—
Motif Detection »
Find Peaks »
Find Peak Pairs
Displacement Maps
Define Reference
Correct Scan Line Noise...
Strain Map...
Repeat Project...
Project »
Image Group »

Analyze Peak Points
Analyze Equivalent Columns...

Histogram from Spreadsheet

Show/Hide »

Add Color Marker Reference Base Vectors
Create Vector Map...

Distortion Correction »

Help >
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Real Space Noise Filters

While Bragg filtering is very useful to reduce noise, some researchers may prefer other
alternative noise filtering techniques in real space. There are two alternative noise filtering
commands: Adaptive Wiener Filter and Low Pass Filter. The techniques have no way to
determine automatically the basis vectors, and they should be determined manually by using
the Set Reference Base Vectors command

Adaptive Wiener Filter

The Wiener filter is widely used for image restoration and calculates the optimal filter for the
removal of noise from a signal which is corrupted by the measuring process itself. It assumes
that if noise is present in the system, then it is considered to be additive white Gaussian noise.

In a typical Peak Pairs session, if Wiener filtering is desired, it is usually the first operation to
be applied to the original image. When applying the Adaptive Wiener Filter on the front
image, the user should decide the size of the windows used for calculating the Adaptive
Average and the Noise Estimation, as follows:

PeakPairs

Fourier Space Noise Filter

>
Real Space Noise Filter Adaptive Wiener Filte - i X
<$ i~ Wiener Filter LE-J

Set Reference Base Vectors

Motif Detection 4 .

Find Peaks N New Project: Projectll

Find Peak Pairs . -
e s Adaptive Average: | 1 x2+1pixels

Define Reference Noise Estimation: Il_ x2+1 pixels

Strain Map... [

Correct Scan Line Noise...

OK ][ Cancel ]

Repeat Project...

Project >

Image Group »

Anjyze Peak Points If the standard deviation of the local area is small, then the
Ansipe Equimient Colmrs- pixel value will be replaced by a local average. On the
Shtng:‘fmspdht , other hand, if the standard deviation of the local area is
paa o large, then the pixel value will not be modified. Thus, the
Distortion Correction , new pixel value will be between the old value and the local
Help 8 average according to the local standard deviation.

The result of the Wiener filtering operation on Test image.dm3 (Adaptive Average =3, Noise
Estimation=3) is depicted below.

i B: PPA Test 1 = |-® |5 | - I: Projectl AWF of PPA Test 1 o 2=
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Low Pass Filter

In order to generate a Low-Pass filtered image, use the Low Pass Filter command on the
front image. The strength of the filter is defined by the Radius of the mask in pixels (the
larger the radius, the stronger the filter):

PeakPairs

Fourier Space Noise Filter >

Real Space Noise Filter 4 Adaptive Wiener Filter..,

Set Reference Base Vectors RS ik >

Motif Detection » B Low Pass Filter léj
Find Peaks »

Find Peak Pairs New Project: | Project3

Displacement Maps

Define Reference Radius (DiXED: 2.0

Correct Scan Line Noise...

Strain Map... [ OK ] [ Cancel ]

Repeat Project...

Project > . . .

Image Group 8 The new pixel value will be a local average with a
Analyze Peak Points Gaussian weight (mask) of the defined radius. You
S can specify a radius of les than one pixel.

Histogram from Spreadsheet
Show/Hide >
Add Color Marker

Create Vector Map...

Distortion Correction »

Help >

In the following figure, the resulting images after the application of a Low-Pass filter to the
lower left part of Test image.dm3 with different radius are shown:

e N7 r

iz B: PPA Test 1 o |[@ ][ =] || g A: Project1 LPFof ... [ = |[ @ |[ 2 t= A: Projectl LPFof ... [ o |[ @ |[ &= ]

Original image Low Pass Filtered Low Pass Filtered
(right-lower corner only) (radius=0.8 pixels) (radius=1.6 pixels)
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Geometric distortion correction

All optical systems distort the images they form. CCD cameras and scanners (for digitising
negatives for example) introduce additional distortions. If these geometric distortions are
fixed (what is usual for a given system), it is possible to eliminate them. This is valid not only
for projector lens distortions but also for any other systematic distortions present in the image.

In order to correct the distortions, an image of a perfect crystal is needed. We explain here
distortion correction using a pair of images with the same distortion, 7est image.dm3 and
Substrate.dm3, the latter of which corresponds to an image of a perfect crystal.

Open the image Substrate.dm3, execute the Power Spectrum, and then Bragg Filter in
the usual way by selecting relevant spots in the Power Spectrum.

téz A: Power Spectrum of Substrate [e)[®@] =

¢iz B: Substrate [olre ==

- Bragg Fiter
Project Name: [ Project1

Size:
Smoothing Width: [5.0
[VlovalRatio: [1.0
Direction: [0.0  degree

Then calculate the Peak Pairs using the usual commands (Find Peaks followed by Find
Peak Pairs). If we analyse the displacements with the Displacement Maps command, we
can observe that the image of a perfect crystal is distorted as shown below.

ez N: 5 Q:
Filtered Substrate &= N: Project1 D1h = [@ =] | & Q: Project1 Div ol[@][=

= P: Project1 D2h = |[@ ][] | & R: Project1 D2v o @)=

24



HREM Research Inc. PPA for DM Manual

The distortion information obtained for the perfect crystal image can be used to correct
distortions in any other image with the same distortion. In order to obtain the distortion
information, select the image with Peak Pairs information, and apply the command Obtain
Distortion Info.

PeakPairs

Fourier Space Noise Filter >

Distortion Info of Substrate [fole ==

Real Space Noise Filter >
Set Reference Base Vectors

Motif Detection 4
Find Peaks 4

Find Peak Pairs
Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project >

Image Group >

Analyze Peak Points
Analyze Equivalent Columns...

Histogram from Spreadsheet

Show/Hide »

Add Color Marker

Create Vector Map...

Distortion Correction »

Obtain Distortion Info

Help >

The new image with distortion information will be created. This Distortion Info image can be
saved to disk (e.g., Distortion Info of Substrate using Save As command) and used in further
analysis of the image having the same distortion.

In order to rectify the original image using the distortion information obtained from the
perfect crystal image, just apply the Correct Distortion on the Target Image as follows:

PeakPairs

Fourier Space Noise Filter >

Real Space Noise Filter > t'-;.—_' COfTeCt DiStortion l&l

Set Reference Base Vectors

Motif Detection ’ Target Image: [D:Testimage 918k ']

Find Peaks 4

Find Peak Pairs Distortion Info: [S: Distortion Info of Substrate 2758k v]
Displacement Maps

Define Reference [ OK ] [ Cancel ]

Correct Scan Line Noise...

Strain Map...

Repeat Froject. , Select the Target Image (the image to be
Project . . .

e Group b corrected), and the Distortion Info (the image
Analyze Peak Points created by the Obtain Distortion Info command).

Analyze Equivalent Columns...

Histogram from Spreadsheet

Here, we use the Test image.dm3 and the Distortion

Show/Hide »
Add Color Marker Info obtained from Substrate.dm3.
Create Vector Map... ’——é
Distortion Correction < » Correct Distortion... >
Help >
Rectify Image...
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This will produce a corrected image, where all the est image oo e
distortions estimated from the perfect crystal image |#&
have been eliminated.

We can now proceed to analyze this image in the
usual way to get the final results:

Define reference
Strain maps

1. Power Spectrum

2. Bragg Filtering

3. Find Peaks

4. Find Peak Pairs

5. Displacement Maps
6.

7.

The strain maps before and after distortion correction:

~y ~y

iz J: Project2 exx [o][@ ][ =] | g L: Project2 eyy [a[@] =] o W:Projectdexx [ o | @ |[ 88 ] | ¥ Y: Project eyy [e[@]=]

g M:Project2exy  [o | @ |[ 8| | gz O: Projec2eyx [o |[@ [ 5= ]

- Z: Project4 exy t= AB: Projectd eyx [ o || @ [ 52|

before correction after correction

If we plot a horizontal profile across exx and a vertical one across eyy, we get the expected
results (exx=0.1 and eyy=0.05) after distortion correction.

= D: Profile Of Projectd exx [E=R[E=R~= = G: Profile OF Project4 eyy o [@]=]

o.

on
010
008
0.08
007
0.06
0.05
0.04
003
002

001

0.004
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Additional functions

Peak Analysis (Analyze Peak Points)

The Analyze Peak Points command applied on the project image, such as Bragg filtered
image, will generate an output in spreadsheet including the following information (one row
for each lattice peak):

- Peak position at sub-pixel resolution (x,y coordinates)
- Peak intensity
- Strain tensor at each peak points (exx,eyy,exy and eyx): only after Strain Analysis.

Help - ~ ~ .
- i D: Lattice Points of Project3 Bragg Filtered PPA Test 1
Fourier Space Noise Filter » r3 7 Harght BT 5 i R g
Real Space Noise Filter » mean |237.574 238.692 2.82694 00273326 |0.0146443 |-0.00534172[-0.00987758| |
std_|137.592 136.723 0.113333 | 0.0480278 |0.0317812 |0.0146789 |0.0149231
Set Reference Base Vectors Pr_ |s.72518 11.8867 2.68881 -0.066703 |-0.0423194 |0.0263026 |0.0260812
£z 713892 241.753 2.852 -0.0333832 |0.0203174 |-0.01035 | -0.00851274
Motif Detection 4 23 |7. 12398 229.672 2.81862 -0.0407684 | -0.00025249]0. 00138291 | -0.00871415
Find Peaks » P4 |7.20828 205.776 2.7538 -0.030673 | -0.0076317 | -0.00267347 -0.0151094
Py |7.2091 217.682 2.73 -0.0375265 | -0.00326502| -0. 00502334 -0 0186023
Find Peak Pairs P5_|7.22218 279178 2.84895 -0.0368814 |0.0397605 | -0.0101031 | -0.0231907
: P7_|7.2258a 254. 169 2.77886 -0.0361018 |0.047856 | -0.0138327 | -0.0143577
(T RS P8 |7.28578  |286.711  |2.63983 | -0.0398632 |0.042157 |-0.0012523 |-0.0256778
Define Reference P |7.30935 133,864 2.91845 -0.033584 | -0.00427666| 0. 00582282 | -0. 00279915
Correct Scan Line Noise... P10 _|7.33798 291,671 2.79103 -0.0388477 |0.0460278 | -0.0152384 |-0.0186443
Pi1_|7.a1728 304.227 2.75082 -0.039785 |0.0461593 | -0.0137371 | -0.0260204
Strain Map... P12 |7.42404 181.897 2.89344 -0.033371 [0.0038351 [0.00115376 |-0.00858061
P13 _|7.5a168 169871 2.66301 -0.0433459 | -0.00104136| 0. 00535647 | -0.0108181
Repeat Project... P14 |7.58362 316.693 2.73329 -0.0418819 |0.0348251 |-0.0202437 | -0.026883
Project » P15 _|7.7027 157. 965 2.6661 00400217 |-0.00907148| 0. 00656087 | -0. 00786243
P16 _|7.73628 329.073 2.66285 -0.042688 | 0.0332012 | -0.0172725 | -0. 0306297
)ﬁﬁﬂ“—" P17 _|7.87523 126,064 2.76209 -0.0403106 | -0.00709395|0.0125334 | -0. 00436703
) P18 _|7.31922 341. 448 2.85664 -0.0358251 |0.0306097 | -0.0253737 | -0.0389183
C Anavzs Peak Points > P19 8. 07368 353.783 2.82647 -0.0327167 |0.0273665 | -0.0159979 | -0.0378463
TG | P20 811374 134.204 2.693 -0.0431512 [-0.0153224 [0.0173555 [-0.00192633
Histogram from Spreadsheet P21 |8.2421 366. 123 2.79355 -0.0347414 |0.0316551 | -0.0269653 | -0.0378794
£22_|s. 40503 122.458 2.68165 -0.0506372 |-0.0154679 |0.0143573 | -0.00359978
LIRINE » P23 _|5.50759  |378.452  |2.92367 -0.0383204 | 0.0225834 | -0.025283% | -0.0330471
Add Color Marker £24 |s.6783 11053 2.73576 00523373 | -0.00043692|0.0187727 | -0. 00410883
225 _|8.72908 390.634 2.8968 -0.0420334 |0.0165246 | -0.0227335 | -0. 0380875
Create Vector Map... —— - B OO TR T B EREEE———
- ) < v
Distortion Correction »
Help >

It is also possible to get a histogram from the Spreadsheet by using the Histogram from
Spreadsheet command, thus obtaining a different histogram for each column in the

spreadsheet.
e clels]]
Fourier Space Noise Filter > ]
==
Real Space Noise Filter » LS =L
[EenEa)|
Set Reference Base Vectors
o [ @] =R W
Motif Detection » o
g D:Y = [®][= ]
Find Peaks »
B G X o |[®@ ][R ]
Find Peak Pairs
a
Displacement Maps iz F: Height E=Er=]
100
Define Reference
Correct Scan Line Noise... 0
Strain Map... 80-
Repeat Project... 70
Project » 60-
Image Group » | <0
Analyze Peak Points | 40-
U 30
Histogram from Spreadsheet >
. — L 20
L4
Add Color Marker U 10
Create Vector Map... L o4
Distortion Correction >
Help >
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Atomic Column Analysis (Analyze Equivalent Columns)

Once Peak Pairs have been located, it is possible to analyze atomic column positions. This is
very useful when there are more than one atomic column within a unit cell. For example, in
the case of [110] projection of InP (the zincblende type materials), we can evaluate cation
and/or anion atomic columns. In order to do so, go through the following steps (on the

zincblende.dm3):

= N: Project4 AWF of zincblende_110 oo =]
- Calculate Peak Pairs in the usual way ' s

s N =)

- Bring the original raw image to
frontmost.

- Choose the area of interest on the
original image using the Rectangle ROI
tool.

- Select atomic column(s) to be analysed
using the HREM mouse. (Here, we
select a set of cation and anion columns)

.___‘__

- Bring the project image with Peak Pairs
information to frontmost.

.___‘__

- Apply the Analyze Equivalent
Columns command

o L S All the columns in the selected area will be shown in the
Fourier Space Noise Filter > . . . . .
— R image, and the intensity of each column will be stored in a
Set Reference Base Vectors SpreadSheet
Motif Detection > - .

EinGPears » pi= D: zincblende_110

Find Peak Pairs

Displacement Maps

Define Reference * .
|
Correct Scan Line Noise... :9 :
|
Strain Map... | :
9 |
Repeat Project... : |
|
Project > :
| »
Image Group > | :
1
= : ®
I 1
|
c Analyze Equivalent Columns... > d {3 :
e —TTT———— | ! -
Show/Hide 4 | o |'
|
Add Color Marker IR :
| |
Create Vector Map... | y
o e
Distortion Correction » |
™) &
Help » ™

|

|

i
*

|
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If there is more than one column, the user will
have the option to evaluate the distances between

the columns.

If there are more than two columns, the user will
have the option to evaluate the angles subtended

-
- U: Distance_zin...

-2 s - 5
mezn | 6. 36442 iz AD: Peak_zincblende_110 o || =]
B . A < S o [ -2
—— DEOD mean | 101.92 106. 428 0.306528 | 104.0386 112,408 0.0830263 |7

2 5 37162 std_|aa. 1637 441373 0.00143186 | 44. 1625 441216 0. 000641297
::f W Posl |35.7585 43.9015 0.310308 | 37.9353 49.3347 0.0832183
—— e Pos2 |31.5959 58. 2847 0.305591 | 33.7563 64.273 0.0818131
— R Posd | 27. 4481 72.7036 0.30573 29. 6055 78.7041 0.0829192
Pos7 | 6. 37638 Pos4 |35.6929 95. 4335 0.304343  [37.9096 101.507 0. 0836382
— OO PosZ [31.543 109. 836 0.307186 | 33.7247 115.84 0.0841879
Posd |6.374 Posd [39.8894  [81.0467 0.30447 42.0678 87.011 0. 0830656
Pos10| 6. 37056 Pos7 |27.346 124.263 0.30509 29.5528 130.245 0.0826102
- Posd | aa. 0382 66.6424  |0.305346  |46.2163 72869 0. 0830897
Posg [52.4104  [37.8367 0.306119  |54.5977 43.8237 0.0837043
Posig| as. 2239 52.2539 0.305862  |50.3818 58.2479 0.0817484 | _
Ae=eel an aen Tan car ammnaia  Tas anne “an ean Y YY YT
y in

by two neighbour columns.

iz Analyze Equivalent Columns u

Distance I Angle | Option |

M1 @2 [C3

Distances from the checked point(s) to
other points will be evaluated.

(=

ok | [ cancel |

iz Analyze Equivalent Columns u

Distance Angle |Opﬁon|

M1 @2 O3

Checked point(s) will be a vertex of angle(s)
subtended by two other points.

ok | [ cancel |

(=

You can see visually the distribution of distances using the Histogram from Spreadsheet
command:

e H: 12

6.

[E=8 HoR =3

5.5

5.0

45

4.0

3.5

3.0

2.5

2.0

15

1.0
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Correct scan line noise

There are situations in which the electron microscopy image is altered by the presence of
scanning errors, such as small beam deflections due to external electromagnetic fields, as well
as hysteresis effects during the ‘fly back’ between scan lines, that may severely distort strain
results. The presence of scanning errors may be identified as the presence of annoying stripes
in the strain results. In these cases, the option Correct scan line noise may be quite useful.

In order to show how to use this option, let us calculate strain results on the image
QuantumWire50Hz.dm3 in the usual way, as we did with QuantumWire.dm3 image in
previous pages. We will get the similar Power spectrum as shown below:

= C: Power Spectrum of QuantumWireS0Hz P e ===

If we specify the lattice base vector (#1 and #2 as indicated), displacement maps shown below
may be obtained. As we may observe, a set of stripes is shown in these maps:

& P: Project1 D1h [= @[] | & v: Project1 p1v = @)=

e W: Project1 D2v oll® =

We can then Add a Rectangle ROI in one of the Bi P e Bi Nl €

Displacement maps (here, the image U). i
i Rectangle
| Add a rectangle ROI
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Then, press the Correct Scan Line Noise option to remove the stripes and determining a
proper displacement map.

PeakPairs £ P: Project1 D1h [o (@[] | & v: Project1 D1v (e @=]

= Fourier Space Moise Filter >
| |

Real Space MNoise Filter
i Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps

Define Refer
(Correct Scan Line Noise..)

Strain Map...

You can extend the reference area for. the scan-line v Correct Scan ... u
correction from the very top to the bottom lines, when you
check “Correct All Line” in the dialog. Correct All Line

[ OK ][ Cancel ]

Unfortunately, in this example there is no perfect reference area from the top to bottom of this
image. Therefore, we have horizontal artefacts as clearly see in the images V and W.

The scan-line correction has a capability to merge multiple reference areas. Here, we use two
reference areas at the top left and the bottom right. Then, we can better perform the scan-line
distortion as shown below. There is no appreciable artefact observed before.

= Q: Project1 D2h | =5 EoE ) 2 N: Project1 D1h = |[@][=] | @ Q: Project1 D1v. s [@]=]

32 P: Project1 D2h
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Create Vector maps

It is possible to a create vector map from two vector components, such as D1h and D1v. To
do so, launch the Create Vector Maps command, and select two vector component images
of the associated vector map.

We explain here this function using the displacement maps, D1h and D1v, calculated from
Substrate.dm3. After launching the Create Vector Map command, select these two images,
D1h and D1v, and press OK.

PeakPairs | Help -
Fourier Space Noise Filter > L‘r: Create Vector Map @
Real Space Noise Filter > Select two components
Set Reference Base Vectors Horizontal: [O: Project3 D1h ']
Motif Detection » Vertical:  [R: Project3Div -
Find Peaks > Ao
Find Peak Pairs Interval: | 16 pixels
Displacement Maps Length Scale: llo—
Define Reference (Length = Scale * Interval)
Correct Scan Line Noise... Color: R [100 % G [0— % B [0 o
Strain Map...
Repeat Project...
Project » .
Image Group > d . ) N o —
Analyze Peak Points .i-,e—_' Z PrO]eCt3 Dlh EI@ t’t' AC: pl’O]eCt3 D1v ‘i”ﬂ”&’
Analyze Equivalent Columns...
Histogram from Spreadsheet
Show/Hide »
Ad
< Create Vector Map... '>
— G o o
Help >

Then, you will get a colour map corresponding to the vector magnitude, with arrows showing
the directions and magnitudes of the vectors as shown below:

& K: Vector Map =3 )

The vector map here is a complex DM image, whose real and imaginary parts correspond
respectively to the Horizontal and Vertical images selected in the dialog.
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Image rectification

This command allows the user to correct any distortion from an image of a perfect crystal,
using Peak Pairs information. We explain here distortion correction using an image
corresponding to a perfect crystal, Substrate.dm3.

Open the image Substrate.dm3, execute the Power Spectrum, and then Bragg Filter in
the usual way by selecting relevant spots in the Power Spectrum.

A: Power Spectrum of Substrate o |[®@][=]

: Substrate

Smoothing Width: | 5.0
[VlovalRatio: [10
Direction: [0.0  degree

Then calculate the Peak Pairs using the usual commands (Find Peaks followed by Find
Peak Pairs). If we analyse the displacements with the Displacement Maps command, we
can observe that the image of a perfect crystal is distorted as shown below.

= % V: Project4 D1h '@ ][] | g Y: Project4 D1v
- H: Project4 Bragg Filtered Substrate [foa == = L - ) L =0

= X: Project4 D2h o |[@][ =] | g Z: Project4 D2v o [@] =
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Given that the image corresponds to a perfect crystal, we can get a rectified image. In order to
do that, select the project image with Peak Pairs information, and then apply the Rectify
image command.

PeakPairs I )
Fourier Space Noise Filter > " -
Real Space Noise Filter >
Set Reference Base Vectors
Motif Detection »
Find Peaks »

Find Peak Pairs
Displacement Maps

Define Reference

Correct Scan Line Noise...

I

Strain Map...

Repeat Project...

Project > Base Vector 1
Image Group >

length: [8.6  (3.6019)
Angle: |-135.2 (-135.206)

Base Vector 2

Analyze Peak Points
Analyze Equivalent Columns...

Histogram from Spreadsheet

Show/Hide >
Add Color Marker Leng[h: I 8.59 (8, 58744)
Create Vector Map...
Distortion Correction » Correct Distortion... Angle: I 134.8 (134.792)
Help » Obtain Di ion Info — -

VS Rectify Image... [ OK ] [ Cancel ]

The lengths and angles of current reference base vectors will be shown in the dialog. If the
values in the parentheses differ from the values expected from an ideal unit cell, you can
change the values accordingly.

By pressing OK, the distorted image is rectified using the local distortions at each point of the
image. To verify this, calculate the displacement maps from the rectified image. Then, we
observe that distortions have been corrected as shown below:

t: V:Project4D1h [ o |[@ ][5 ] | g Y: Projectd DIv [ |[-E- ]3] e AC: Project5 D1h [ o |[ @ ][ 52 ] | g AF: ProjectsDIlv. [ o | @ |58 |

tz X: Project4 Dzh Bz Z:Projectd D2 [o (@ |[R] e AE: ProjectsD2h [ |[ @ |2 ] || = AG: Project5D2v  [ro- |- (3w

before correction after correction
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Appendix

Technical Note:
The results of the PPA package is the complete strain tensor defined as follows:

Strain values
du ou _du, ou,

e. = x,e= y’e— y e =

oo M oy Yy Y ax
Strain tensor:
£, = l %_,_ ou, |\ . du du, 1{0u, Ou
= e g =—%, ¢ =—2, ¢ =—[Tx4 2
2 ox,  ox, ox a7 20 d ox

1
Mean dilatation :

1({0u Ou,) .
A =—|—+—L|1e. A =1L(e, +¢,
v 2(3)6[ axj) » 2(' }')

Rotation (in radians and anti-clockwise positive):

1({ou, du ).
w; =— 2 ou ie. o =l %_%
T2 ox,  ox, o2l ax oy
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Some useful DM tricks

DM ROI tool:

PPA for DM Manual

) ek

Hint: to select a square area, hold down SHIFT.
To select powers of two, hold down SHIFT-ALT.

DM Zoom tool:

in( Q2 /00|

Hint: to demagnify, press ALT.

HREM Mouse tool

|§‘ﬂ.@£%@ﬂ

Hint: to delete any spot, just
click on the mouse mark with
the SHIFT key down.

DM Image Display Command

-

=1 | Eo )

iz J: Project3 exx

)

ImageDisplay...

Display Type >

Hint: to change the color map of
any image, press the right mouse
button on it, select ImageDisplay,
and modify the options as desired.

For example, it is useful to set
manually the color range of each
map to be the same, so as to be able
to compare each other.

= J: Project3 exx

==
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Quick Reference Guide

The PPA Main Menu _____LLL
Fourier Space Noise Filter »
Real Space Noise Filter »

Set Reference Base Vectors

Motif Detection »
Find Peaks »

Find Peak Pairs
Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project »
Image Group »

Analyze Peak Points

Analyze Equivalent Columns...
Histogram from Spreadsheet
Show/Hide »
Add Color Marker

Create Vector Map...

Distortion Correction »

Help »

The commands in the PPA menu are described below.

Command

Description

Fourier Space Noise
Filter (see sub menus)

Reduces noise using Fourier space filter.

Real Space Noise Filter
(see sub menus)

Reduces noise using Real Space Filter.

Set Reference Base
Vectors

Set the reference base vectors manually on a
real-space noise-filtered image or an image after
Motif detection.

Note: Bragg filter sets the reference base vectors
automatically.

Motif Detection
(see sub menus)

Detects repeating units (unit cells) using a Motif (small
reference region).
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Find Peaks
(see sub menus)

Locates peaks of intensity in an image.
Note: Reference base vectors should be defined
beforehand.

Find Peak Pairs

Calculates pairs of peaks along two reference base
vectors automatically.

Displacement Maps

Generates horizontal and vertical displacements
along the two directions defined by the basis vectors

Define Reference

Changes the displacement values, so as to obtain a
uniform displacement in the chosen area.

Note: the area should be selected previously using
the ROI tool on any displacement image

Correct Scan Line
Noise...

Corrects imperfect scan-line control (scan-line noise)
of the STEM scanning system using a perfect area in
the image.

Note: the area should be selected previously using
the ROI tool on any displacement image.

Strain Map... Calculates strain maps (exx,€yy,exy and eyy) at any

(see Dialog) desired angle.

Repeat Project... Generates strain maps and other outputs for the front

(see Dialog) most image using the same conditions of a selected
project.

Project Menu to manage all the images in a particular project.

(see sub menus)

Image Group Menu to close or save groups of images within a

(see sub menus)

particular project.

Analyze Peak Points

Generates a spreadsheet of data (peak position, peak
intensities, strain values) for each peak

Analyze Equivalent
Columns... (see Dialog)

Analyzes equivalent column positions, as well as the
distances and angles between specified columns.
The independent column(s) will be specified using the
HREM Mouse tool.

Histogram from
Spreadsheet

Calculates a different histogram for each selected
column in the spreadsheet

Show/Hide
(see sub menus)

Shows/hides a selected annotation on the image.

Add Color Marker

Adds a color bar and the low and high display ranges.
You can move the whole color marker or change its
size. Since the display ranges are text annotations,
you can move and edit them as you like. The color
marker can be placed outside of the image display.
You can rotate and flip using Edit commands. (The
ratio of the color bar is fixed.)

Create Vector Map...
(see Dialog)

Create a vector map from two component images
selected in the dialog.

Distortion Correction
(see sub menus)

Eliminates systematic distortions present in the image
based on the measurement of an ideal distortion-free
image.
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i Power Spectrum |

Fourier Space Noise Filter SubMenu |

Bragg Filter...

Component

Description

Power Spectrum

Calculates the Fourier transform of the front most
image, and displays the power at each frequency
(commonly called the Power Spectrum).

Bragg Filter...
(see Dialog)

Calculates Bragg Filter using the spots selected in the
Power Spectrum. The shape and size of the mask
can be defined by the user in the dialog.

Note: Spots should be selected beforehand in the
Power Spectrum using the Mouse Tool.

Note: The first and second spots defined the
Reference Base Vectors in real space.

Bragg Filter Dialog

The components of the dialog are described below.

Dialog i Bragg Filter [
Project Name: |Project1
Size:
Smoothing Width: | 5.0
(V] Oval Ratio: | 1.0
Direction: |0.0 degree
[ OK ] [ Cancel ]
Component Description

Project Name

Name given to the group of images and results

Size

Defines mask radius of hard cut-off (beyond which
values are set to zero).

Smoothing Width

Specifies mask smoothing width in pixels

Oval Ratio Defines the shape of the oval, as major to minor axis
ratio
Direction Sets the prescribed masks angle, in degrees
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Adaptive Wiener Filter...

Low Pass Filter...

Component Description

Adaptive Wiener Filter... | Remove noise from the image using an adaptive
(see Dialog) Wiener filter based on a local variance.

Low Pass Filter... Calculates and applies a Low Pass filter to the image
(see Dialog)

Adaptive Wiener Filter Dialog

Dialog i- Wiener Filter [
New Project: IProjT
Adaptive Average: [1_ x2+1 pixels
Noise Estimation: IT x2+1 pixels
[ OK ] [ Cancel ]
Component Description
New Project Name given to the group of images and results
Adaptive Average Window size [(2N+1)x(2N+1) pixels] to be used in the

calculation of the adaptive average

Noise Estimation

Window size [(2N+1)x(2N+1) pixels] to be used in the
calculation of the noise estimation

Low Pass Filter Dialog

Dialog iz Low Pass Filter =
New Project: [Projecti|
Radius(pixe |} r
oK I Cancel I
Component Description
New Project Name given to the group of images and results
Radius(pixel) The radius of the mask in pixels
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Define Motif

x-Corr Histogram...
x-Corr with Refined Motif
Find Motif Centers...

Component

Description

Define Motif

Define a Rectangle ROI as a Motif, and make it
rotatable.

x-Corr Histogram...
(see Dialog)

Calculates Cross-Correlation Histogram between the
selected reference region (motif) and the original
image.

Note: The left edge of the selection in the histogram is
used as a threshold to obtain the refined motif in the
next step.

x-Corr with Refined
Motif

Obtains a refined motif, and then calculates
Cross-Correlation Histogram between the refined
motif and the original image.

Note: The left edge of the selection in the histogram is
used as a threshold to find good motifs in the next
step.

Find Motif Centers...
(see Dialog)

Finds the centers of good Motifs in the image.

x-Corr Histogram Dialog

Dialog iz x-Corr Histogram &J
Approximate Column Size (diameter): | 10.0|
Minimum Motif Distance: | 15.0
[ OK ] [ Cancel ]
Component Description

Approximate Column
Size (diameter)

Specifies an approximate atom column size (the
minimum distance between atom column peaks).
(This parameter is used in x-corr with Refined Motif
to define peaks in the refined motif.)

Minimum Motif Distance

Specifies a minimum distance between allowed
motifs. (This parameter is used in Find Motif
Centers...)
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Find Motif Center Dialog

Dialog

7

i Find Motif Cen...@
Peak Threshold: |0.835

(V| Show all points
(] show stacked motif

[ OK ][ Cancel ]

Component

Description

Peak Threshold

Specifies a minimum for the intensity of allowed
Peaks.

Show all points

Shows also the Motif centers in blue that were
rejected by the cross-correlation threshold and/or the
minimum motif distance criteria. (Namely, all the peak
points are displayed in red or blue color.)

Show stacked motif

Make a stacked image from detected motifs.

Find Peaks SubMenu

Peak Histogram...

Find Peak Positions...

Remove Peaks

Add Peaks
Component Description
Peak Histogram... Calculates a histogram of peaks intensities, helping
(see Dialog) the user to determine a precise value for Peak

Threshold.

Find Peak Positions...

(see Dialog)

Locates peaks of intensity in a filtered image. A
threshold for the minimum allowed peak intensity and
a minimum distance for peaks can be defined.

Note: The left edge of the selection in the histogram is
used as a threshold to find good peaks.

This threshold can be changed in the dialog below.

Remove Peaks

Remove the peaks, which are selected by using
HREM Mouse.

Add Peaks

Refine and add the peaks, which are selected by
using HREM Mouse.
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Peak Histogram Dialog

Dialog iz Peak Histogram l_J&
| Invert Peaks
[ OK ] [ Cancel ]
Component Description
Invert Peaks It allows the user to calculate intensity minima
histograms (instead of maxima)

Find Peak Positions Dialog

Dialog pi Find Peaks X
| Invert Peaks
Peak Threshold: |0.825
Approximate Column Size (diameter): | 3.0
[V] Show Local Maxima

[ OK ] [ Cancel ]
Component Description
Invert Peaks It allows the user to calculate intensity minima

(instead of maxima)

Peak Threshold Specifies a minimum for the intensity of allowed

peaks

Approximate Column
Size (diameter)

Specifies an approximate column size (in pixels) to
merge the peaks (columns) within the specified
column size.

Show Local Maxima

Show local maxima (of 8-neighbourhood) as blue
points.

Correct Scan Line Noise Dialog

Dialog gz Correct Scan ... =
(| Correct All Line
[ OK ] [ Cancel ]
| Component | Description
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Correct All Line

It modifies all scan lines, not only those within the
ROI.
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Strain Map Dialog

Dialog

PPA for DM Manual

iz Strain Map X

Option

Angle of x-axis to horizontal: | 0.0

Show the following images
[V] Strain Matrix
Independent
@) Symmetric
(¥ Mean Dilatation
(V| Rotation Angle

[ overlay

[ OK ][ Cancel ]

Option

Description

Angle of x-axis to
horizontal

Specifies the angle of the direction to be considered
as x-axis.

You can specify the orientation of the x-axis by
placing a Line ROI on the HREM image. In this case,
the angle of the Line ROl appears here automatically.
Note: If angle is set equal to 0, horizontal and vertical
directions are assumed to be x and y coordinate axis
respectively.

Strain Matrix

Specifies the images to be shown

Independent

Images of du/dx, du/dy, dv/dx, dv/dy to be displayed

Symmetric

Images of &4, €y, and ey, to be displayed.

Mean Dilatation

Image of 9y, to be displayed (average of ex and eyy).

Rotation Angle

Image of wy, to be displayed. Values in degrees and
anticlockwise positive.

Overlay

Shows the strain at each atomic column, and
displayed as coloured dots over the original image
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Repeat Project Dialog

Dialog

iz Repeat Project léj

New Project: |Project3

Project image to be repeated:

Project! Brage Filtered Testimage ;]

Select
(" Find Peaks
(" Find Peak Pairs
(" Displacement Maps
(¢ Strain Map

oK | Cancel |

Component

Description

New Project

Defines the name of the new project.

Project image to be
repeated

Selects an open project to be used to generate strain
maps and other outputs for the front most HREM
image.

Note: If you want to use the project created during the
previous session, you may want to open it again.

Find Peaks

Repeats Find Peaks Operation.

Find Peak Pairs

Repeats Find Peak Pairs Operation.

Displacement Maps

Repeats Displacement Maps Operation.

Strain Map

Repeats Strain Map Operation.

Project Sub-Menu e
Show
Save
Close
Component Description
Hide Hides all the images in a project.
Show Shows all the images in a hidden project.
Save Saves all the images in a project (with save dialog
window).
Close Closes all the images in a project without saving.
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Save

Close
Component Description
Save Saves (with dialog) all images in a project of the same
type as the front most image (e.g. strain map images).
Close Closes (without saving) all images of the same type

as the front most image.

Analyze Equivalent Columns Dialog

The user will have the option to decide the distances and/or angles to be

evaluated.

Distance Tab

iz Analyze Equivalent Columns [éj

Distance l Angle I Option I

M1 @2 [03

Distances from the checked point(s) to
other points will be evaluated.

[ OK ] [ Cancel

)

The number of each check box corresponds to the assigned number to the
mouse click. All the distance(s) from the checked point to other points will be

calculated.

Angle Tab

i~ Analyze Equivalent Columns ld_z-,l

Distance Angle I Option I
[1 #2 [E]3
Checked point(s) will be a vertex of angle(s)
subtended by two other points.
[ OK ] [ Cancel ]

The number of each check box corresponds to the assigned number to the
mouse click. All possible angle(s) whose vertex corresponds to the checked

point will be calculated.
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Option Tab i~ Analyze Equivalent Columns [

Distance I Angle Option
[V Position (Pos) number on the image
Column coordinate: @) Image origin (topeft)

_) Motif origin (topeft)

[ OK ] [ Cancel ]
Component Description
Position (Pos) number | Display position number (Left column of the spread
on the image sheet) on original image.
Column coordinate (Motif Detection only)
You can select the origin of column positions in the
Motif.
Show/Hide Sub-Menu Peaks
Peak Pairs
Motif
Command Description
Peaks Displays the circle at the peak positions on the image.
Peak Pairs Displays the peal-pair lines on the image.
Motif Shows/hides Motif
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Create Vector Map Dialog

Dialog pi- Create Vector Map [
Select two components
Horizontal: [O: Project2 D1h v]
Vertical: [S: Project2 D1iv v ]
Arrow
Interval: |16| pixels
Length Scale: | 1.0
(Length = Scale * Interval)
Color: R [100 % G[20 % B[s0 %
[ OK ] [ Cancel ]
Component Description
Horizontal Select an image corresponding to the horizontal
component.
Vertical Select an image corresponding to the vertical
component.
Interval Specifies an interval to draw arrows (in pixel)

Length Scale

Specifies an arrow length. An actual length is Interval
* Scale (in pixel)

Color

Specifies an arrow color in RGB.
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Correct Distortion...

Obtain Distortion Info

Rectify Image...

Command

Description

Correct Distortion...

Rectifies any distorted image using the distortion
information obtained previously from an undistorted
sample using the “Obtain Distortion Info” command
below.

A dialog to select two images will be opened.

Obtain Distortion Info

Extracts distortion information from the Bragg image
of an undistorted crystal after calculating Peak Pairs.
This information will be used by the “Correct
Distortion” command above.

Rectify Image...
(see Dialog)

Rectifies an image of an undistorted crystal after
calculating Peak Pairs.

Default basis vector are automatically chosen from
the first and second selected Bragg spots. Basis
vectors can also be manually specified/modified by
the user.

Rectify Image Dialog

Dialog

'

|5

i~ Rectify Image

Base Vector 1

Length: |8.6 (8.6019)
Angle: |-135.2 (-135.206)

Base Vector 2

Length: |8.59 (8.58744)
Angle: [ 134.8 (134.792)

[ o

][ Cancel ]

Component

Description

Length

Length of base vector considered for image
rectification, measured in pixels

Angle

Angle of base vector considered for image
rectification, measured in degrees
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